
PENSORD

January 2006

THE MAGAZINE FOR PENSORD CUSTOMERS

Customers reap the rewards 
of our investment programme

Third eight-unit press now installed
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Total amount raised 
for charity revealed
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:Delano Q&A session
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E D I T O R ’ S  N O T E S

At this time of year it is really important to hit the
ground running after the festive break. 

The temptation, of course, is to coast gently back
into work after a relaxing Christmas but we are
determined to maintain our momentum and
continue to build on the improvements to our
customer offering in recent months. 
As a result we have had a flying start to 2006!

Inside you can read about our latest investment – our third, new
generation eight-unit press – installed to deliver even more
reassuring capacity for our customers.

Customer support

You can also find out more about our revolutionary :Delano system,
as Commercial Director Darren Coxon answers the most frequently
asked questions, and shows you how this ground-breaking web-based
file delivery and approval tool can put you in total control.

We also have our regular PDF support slot offering useful tips from
our resident pre-press expert, Jon Bessant. Plus news of our latest
training initiatives as well as profiles of new staff, who have joined
us to enhance the service we offer.

In our Industry Voices section, you can read PPA’s preview of
Magazines 2006 and familiarise yourself with Publishing Expo – a
new exhibition event to be launched in April.

Charitable Trust status

And we bring you great news of our charity fund, which has just
been awarded Charitable Trust status. We also announce the
amount of money raised for our adopted charity, the Hospice of
the Valleys. 

We are proud of what we achieved last year for our customers and
we hope all the news we have squeezed into this issue of the
Pensord Edge provides an indication of our determination to
achieve even more for our customers in 2006. We hope you enjoy it
and, as always, welcome any feedback on your thoughts about our
newsletter.

Contact me on tony.jones@pensord.co.uk or 01495 223721.

Tony Jones, Chief Executive, Pensord
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All your questions answered

Welcome to our first edition in
2006 of the Pensord Edge. 
I hope 2006 has kicked off
successfully for you and that a
prosperous year lies ahead for
your business.

A FLYING START 
TO2006



I N V E S T M E N T  N E W S

BACKING THE TEAM

At the time of the MBO in June 2003, we recognised that Pensord
was a company with massive potential. We had great confidence in
the talent and commitment of the people already in place and
believed that with strong management backing and significant
investment, the team would have the tools to deliver an even better
service for publishers. It’s less than three years since the MBO, but
in that short time we have taken investment in new equipment to
over £7m and continued to strengthen the team across the board
with a carefully controlled recruitment programme.

Tony Jones says: “It’s vital to control carefully our growth to ensure
we maintain our high levels of service for customers. We have been
making timely investments at each stage of our development and
are always seeking ways to improve, always moving forward, always
asking ourselves what can we do to enable us to exceed the
expectations of our customers. Our readiness to invest in the latest
technology, equipment, and the skills of our people shows our
commitment to raising standards ever higher”.

A new generation

This month saw the installation of the company’s third Heidelberg
eight-unit perfector press. As the new generation Heidelberg, it
includes many revolutionary features that further boost the
capacity and efficiency of these tried and proven magazine presses.
Its timely arrival is part of our ongoing investment across the
business to ensure we can offer even more reassuring capacity for
publishers. Further investment has been made in a new Agfa
platesetter that can handle an impressive 40 plates an hour and we
have recently installed another high-speed folder to bring our total
of folders in the fleet to five. It all means we are better equipped
than ever to handle your magazine title.

PA G E  T H R E E

THE SUPPORT OF THE

WELSH ASSEMBLY

GOVERNMENT 

The Welsh Assembly Government has
been impressed with the way we do
business and is closely monitoring our
progress. We are one of only 60 Welsh
companies to be cherry picked for the
KB4B (Knowledge Bank For Business)
initiative set up for companies with
significant potential for growth to
create a more streamlined one-stop-
shop approach to public sector
business support. 

A stable future

This is great news for everyone
associated with Pensord. Any future
support from the Welsh Assembly
Government will help to strengthen the
stability of the company even further
and provide extra reassurance to our
customers, staff and suppliers that we
all have an exciting and successful
future ahead of us.

Steve Davies (Operations Director,
KB4B) of the Welsh Assembly
Government said: “KB4B is an exciting
new approach to developing high
growth companies in Wales that have
the potential to make a significant
impact on the regional economy.
Having met the management team at
Pensord, it was clear to us that they
were ambitious and committed to
further growth. By providing focussed
and bespoke support to companies like
Pensord we can help them realise their
future growth plans.”

As easy as
1-2-3 for our
customers

Third eight-unit press installed



£12,124
raised in our first year
The Charity Commission has recently granted
Charitable Trust status for the Pensord charity
fund, satisfied that it and the board of trustees
meet the required criteria. This is a significant
step as we continue to raise money for our
adopted charity, the Hospice of the Valleys. 

This month we made our first donation of
£12,124 to Andrew Richards, Chief Executive of
the Hospice. 

This fantastic figure was raised by: 

Giving £1 to the Trust for every project we quote
on

Donating a proportion of Pensord profit to the
Trust

Organising a fundraising sponsored walk 

PA G E  F O U R

Charitable Trust status
granted

Hospice Chief Executive, Andrew Richards, reports:
“Hospice of the Valleys now costs over £15,000 a
week to run. Our services are designed to give
patients and their loved ones the absolute best in
end-of-life care and we employ only the highest
qualified and skilled clinicians.

“Our home care service costs in the region of £313K
each year and our clinics £193K, so the support of
Pensord and the money raised for us will be a great
help in providing this level of specialist care. 

“Everyone at the Hospice, staff, patients and friends
would like to thank you all for the magnificent
support shown to us since you chose us as your
charity”.

Finance Director Graham Lambert said: “We are
delighted to achieve Charitable Trust status, and to
make a contribution to the invaluable work of the
Hospice. 

All of our people can now feel part of two
organisations: the company and the separate
Charitable Trust; which bind together our commercial
and social objectives and activities”.

A fantastic effort

Raising such a large sum of money for the Charitable
Trust in our first ever year is a fantastic achievement
and all down to the effort and support of our
colleagues, customers and suppliers. 

The goodwill and kind wishes we have received
throughout the year for our charity initiatives have
been much appreciated.

Just one example of the heart-warming generosity we
have witnessed came from our Bindery department
just before Christmas when a totally unprompted
collection was made by the Bindery team and
presented to the fund. 

Tony Jones says: “Over thirty people dug into their
pockets and raised £80. This great gesture shows
how we’re all really behind the cause. Let’s keep up
the efforts throughout 2006.”

charitable

C H A R I TA B L E  T R U S T  U P DAT E

Pensord took a big step towards raising over £12,000 for the Hospice with
their sponsored walk. With Tony Jones and Graham Lambert (left) of
Pensord are Hospice Chief Executive Andrew Richards and Clinical Services
Director Sister Jayne Medlicott.
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Pensord staff raise £5,662 in a sponsored walk 
at Cwmcarn Scenic Drive for the Hospice.

Over 80 people took part in the ‘Walk the Walk for the
Hospice’ – our first fundraising event for the Hospice
since the charity was adopted by our Charity Team in
the summer. 

Staff, their families and friends followed the six-mile
Sunday morning route through the beautiful
countryside at Cwmcarn. It was called ‘Walk the Walk’
because at Pensord we pride ourselves on doing what
we say we will do – not just ‘talking the talk’. 

Rob Stainer, a Mailing Operator, said: “I’m glad to be
doing something for a good cause, and such a
worthwhile charity.”

Pensord Chief Executive Tony Jones said: “We were
really pleased at the turnout for our first event, and
people put in a lot of effort to raise the total we
achieved, including a number of our generous
customers and suppliers.” 

Some walkers were more adventurous than others.
Commercial Director Darren Coxon and his son Harry
dribbled a football all the way, and played ‘keepy-uppy’
on the top. 

Pensord was attracted to the charity because of its
nationally recognised track record in caring for local
people in their homes. The Hospice is well
established with strong local links with
the health service and other
healthcare providers in the area.

Tony Jones again: “I’m grateful to the Forestry
Commission and Caerphilly Council for their help in
the organisation of the walk, and for ASDA in
Caerphilly for their donation of refreshments. I’m
proud of everyone’s efforts, and look forward to the
next fundraising event for the Hospice.”

Planning our 
next big event
Over the coming months we will be planning
the next big charity event in aid of Hospice of
the Valleys, and we are delighted to announce
that we will continue to raise funds through
our £1 per quote initiative, and by donating a
proportion of company profits. We’ll update
you in the next edition of the Pensord Edge.

Walking the Walk for Hospice
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KEEP YOUR
DIARY FREE 
FOR PPA’S

PPA REVEALS ITS PLANS FOR 2006

PPA Magazines 2006 will be bigger and better than
ever. Taking place on 2 and 3 May at London’s
Grosvenor House, the magazine industry’s annual
national conference comprises 13 separate
conference streams covering all aspects of the
magazine publishing industry, and three awards
ceremonies. 

This year the event will also incorporate London 06, the fifth
international FIPP business magazine and professional media
conference, hosted by the International Federation of the
Periodical Press (FIPP) and organised by PPA Professional. Lord
Heseltine, chairman of Haymarket Publishing Group and David
Levin, chief executive of United Business Media have been lined up
as keynote speakers for the event. 

Other top speakers include Helen Alexander, group chief executive
of The Economist Group and PPA chair-elect; Keith Jones, chief
executive of Reed Business Information; and Tim Weller, chief
executive of Incisive Media. 

The conference, which sees attendance from professional media
publishers across the globe, has previously been held in Norway,
Germany and Spain. Sessions will address key topics such as
leading in the information world, making money online, search and
leveraging brands. 

In addition to the international business media conference, on
Tuesday 2 May Magazines 2006 will include specialist conferences for:

Business magazine editors
B2B circulation managers (new for 2006)
Finance directors
Independent publishers – including the Independent Publisher
Awards
Production managers
Retail specialists

For Publishers seeking to
improve their own personal
skills and knowledge and
identify opportunities to build
more profitable businesses,
PPA’s Magazines 2006 Awards
for Editorial and Publishing
Excellence is not to be
missed.

Every year Pensord is impressed with
the quality of the event and the way
the organisers successfully cater for all
publishers, whether they represent
smaller businesses or large
organisations. 

That’s why we are heavily involved
once again in 2006. We will be
sponsoring the award for the Publisher
of the Year (for companies with fewer
than 50 employees); and we’ll be
supporting IPAC for smaller publishers. 

This year looks like being another
success with a highly intensive and
informative schedule planned, so we
offered PPA Deputy Chief Executive
Nick Mazur the opportunity to explain
why our customers should keep their
diary free!

PPA Deputy Chief Executive Nick Mazur extols the
virtues of Magazines 2006



I N T R O D U C I N G  M A G A Z I N E S  2 0 0 6 PA G E  S E V E N

Introducing
Publishing Expo
We are pleased to support events that
are intended to serve the best interests
of publishers. 

Publishing Expo is a new exhibition
event that takes place in April 2006
and Pensord will be participating as
an exhibitor.

One of Publishing Expo’s founders,
John Bednall, who also helped establish
Total Publishing, introduces his vision
for an event described as “the newest
and most comprehensive event for one
of the UK’s fastest growing and most
successful industries.”

John says: “Investigating a number of
opportunities, my colleague Nick Field
concluded that the launch of Publishing
Expo was the very top priority in view
of the amazingly positive feedback he
had received from publishers and
suppliers. The show will present the
entire magazine publishing industry
with its own dedicated exhibition event,
covering everything from printers,
paper suppliers and workflow solutions
to publishing software, circulation and
distribution services and picture
libraries.

“There will also be an extensive free
educational programme of seminars,
master classes and demonstrations on
relevant topics by leading industry
names.

“Since we launched, we have been
delighted by the positive industry
reaction and the rapid uptake of
available exhibition space.”

FIND OUT MORE

Further information may be obtained
on www.publishingexpo.co.uk

Wednesday 3 May includes specialist conferences for:
Consumer editors
Credit managers – including the Magazines in Credit Awards
Interactive publishers
Publishing executives interested in personal development (new
for 2006)
Subscriptions managers
Senior consumer magazine publishers (new for 2006)

The event culminates in the presentation of the 26th PPA Awards
for Editorial and Publishing Excellence, the ‘oscars’ of the
magazine industry. The awards are dedicated to upholding and
celebrating the highest standards in all aspects of magazine
publishing. They represent a unique opportunity for gaining
industry recognition for the outstanding achievements of a
publication or individual during the past year. Twenty-two awards
cover a range of different categories and everyone who takes away
one of these awards can be proud that they have set a new
benchmark of excellence. Pensord will again be supporting the
awards, sponsoring the award for the Publisher of the Year (for
companies with fewer than 50 employees). Tony Jones will once
again be chairing a judging panel. 

SPOTLIGHT ON INDEPENDENT PUBLISHERS

Pensord is also supporting the Independent publisher track at
Magazines 2006, a conference stream that has grown enormously
over the past few years. It now acts almost as a stand-alone event
at the annual PPA conference, and last year attracted nearly 100
delegates. Plans for this year’s sessions include case studies of
how independent publishers have successfully grown and sold their
businesses, and a discussion on smaller publishers’ options
regarding alternative routes to market. 

The day also incorporates the fourth annual Independent Publisher
Awards, designed to recognise and reward the entrepreneurial spirit
and achievements of independent publishers. Tony Jones has
chaired the judging panel for these awards since their inception,
and both Tony and Darren Coxon have spoken at sessions at
previous PPA Magazines conferences.  

Further details about Magazines 2006 can be obtained from Hilary
Weaver at PPA on 020 7400 7526 or visit www.london06.com for
more details of the international business media conference.
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Aiming higher
for customers

PA G E  E I G H T

THE TRAINING NEVER STOPS

On completion each person filled out an assessment to show they
understood the training, and in return they will receive certification.
Pensord will be conducting a scheduled follow-up review/refresher
in the spring.

Consultant Helen Stevens said: “The five sessions of the training
programme to introduce The Charter were successfully completed
before Christmas. The implementation of the principles is designed
to support and sustain the ongoing development of the business,
and further training to improve skill levels and add value to the
business is planned for 2006.”

At Pensord, we already have an excellent, highly experienced

customer-facing team. Our further investment in training is geared

towards continual improvement to ensure we deliver exceptional

customer service. We have also taken this opportunity to develop

improved documentation to support the team in their customer

care delivery, and this has been integrated within the programme.

Further work

After completing the training programme, further work continued

with post training assessments and reviews of application of the

training within the job roles. We have invited feedback throughout

the process, and it has been very positive. All the directors are

committed to the programme and to fully realising the practical

application of the pledges set out in our Charter. 

BINDERY BOUND FOR GREATER THINGS

The Bindery is a very busy and demanding area, so it is important

that skills in this department are finely honed. The Bindery Shift

Managers are continuing with their management development

programme and are growing in confidence within the roles. We have

identified areas for improvement and adhere to targeted action

plans sharply focused on raising standards in those particular

areas. In addition, ongoing IT training continues to help staff

become ever more efficient.

TRAINING UPDATE

Here Commercial Director Darren
Coxon outlines progress with
Pensord’s customer care training,
undertaken in collaboration with
Qualtech Services.

Pensord’s in-house customer care
training has progressed well, with all 17
customer-facing staff attending a total
of five weekly modules in November
and December. The programme has
been completely customised to
Pensord and the delivery of our Charter,
and a comprehensive Training Manual
is to be introduced in the Spring.

Specialists Qualtech deliver
five sessions

Helen Stevens (above) of Qualtech
delivered the five sessions, covering the
following subjects:

The Charter:
Establishing internal and external
customers and the importance of
dealing with them properly
Communication:
Written, verbal, telephone etiquette,
handling difficult customers etc
Teamwork:
Understanding colleagues’ roles,
showing empathy, body language,
good team play etc 
Responsibilities, Priorities and
Assessment:
Understanding the expectations of
you in your role, prioritising to meet
deadlines
Review and Assessment:
To encourage buy-in and
implementation
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Acrobat 7 Professional’s 
new Output Preview

The Output Preview tool replaces Acrobat 6
Professional’s Separations Preview option and might be worth the
upgrade all on its own. The Output Preview window can be viewed by
selecting Output Preview from the Print Production item in the Tools
menu or by clicking the Output Preview button on the Print Production
toolbar (View>Toolbars>Print Production).

FEATURES OVERVIEW

Simulation Profile Menu. Select the proofing profile
used to generate a soft proof on screen. 

Simulate Ink Black & Simulate Paper White.
Produces a realistic on-screen appearance which
compensates for the monitor and provides a better
representation of the document printed on a press.

Show Menu. Provides options for display of certain
types of colour and object types, such as CMYK, RGB, Spot, Images and
Smooth Shades.

Preview: Separations. This will show how the object will separate. You
can view a colour breakdown of objects by moving the cursor over
them. Warning: if you have chosen a typical printing profile, all objects will display
in the preview as CMYK - even if they are not!

Preview: Colour warnings: Show Overprinting.
Highlights overprinting objects in the chosen colour.

Preview: Colour warnings: Rich Black.
Highlights Rich Black objects in the chosen colour.

Total Area Coverage. Select a maximum value and Acrobat will
highlight any objects violating this figure on screen in the chosen colour. 

Adobe InDesignCS2

Incredibly, InDesignCS2 does not have as many features for previewing
output accurately. Whilst it boasts the ability to view separations, ink
values and total ink coverage, it does not have the extra feature-set that
Acrobat can now boast. The tool can be found under
Window>Output>Separations.

Acrobat Tips
Local fonts or the PDF fonts?
To ensure you are only viewing the fonts
embedded in the PDF file, open the
Advanced menu and uncheck the Local
Fonts option.

Page size.
You can see the page size of an Acrobat
page quickly by moving the cursor over
the bottom-left corner of the window.
The size will appear in a floating window.

Acrobat and the Version Cue.
Acrobat users can now collaborate with
the Version Cue system with Acrobat 7.
(Enable with Acrobat>
Preferences>General>Enable Version
Cue). 

To use the Version Cue, access the Open
or Save dialogue boxes and hit the
Version Cue button at the bottom-left of
the window. Remember, Version Cue can
be accessed by both Windows and Mac
users regardless of the platform it is
running on.

Keeping up-to-date with Adobe Acrobat.
Be sure to download any updates for
Adobe Acrobat. These not only fix
application bugs, but also potential
security problems. To make sure you
have the latest version, select
Help>Check for updates now.

Go to our Learning Zone on www.pensord.co.uk/pdftoolkits/pdfzone/

This page is dedicated to helping you get the most from the fast-moving world of pre-press 
but space is limited and we can never give you all the help we would like. 

So go to the Learning Zone on our website and you’ll find even more production tips. 
And remember you don’t have to be a Pensord customer, so click and learn! 
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In a nutshell what is :Delano?

Delano is a web-based file delivery and
approval tool. Its main features are its speed
and visibility and the fact that because it is web
based our doors are open 24/7. Files are
uploaded, flightchecked and proofed for
approval to give back complete control to
publishers and at previously unthinkable
speeds.

What do I need to get started?  

Because the product is web based you just
need a decent internet connection, SVG viewer
and Java plug-ins which are both downloadable
from our website. We have a tutorial on our
website too but will also support you either
remotely or with a visit to get you up and
running.

:Delano and your business

Your questions
answered
Here Commercial Director Darren Coxon
poses some frequently asked questions
about :Delano, the web-based file
delivery and approval tool, and supplies
the answers you need.

Q
A

Q
A

Commercial Director Darren Coxon, the man with the answers.



How secure is it?

The system is authenticated using unique
username and password protection which will
allow you to see only the jobs which you are
authorised to see. Different access privileges
can be assigned to different types of users so
for instance only authorised approvers will be
able to approve or reject pages.  

What happens to my pages once I have
uploaded them to :Delano?

Your pages are received by the :Delano
Gatekeeper and delivered to the Apogee X
Normaliser where they are pre-flighted. Each
page is then progressed through our RIPs and
the resultant page proof and flightcheck report
is made available for approval within the job.

Can I send multiple page PDF documents
to :Delano?

Yes. When uploading the file you will be
prompted to state where in the job the pages
should be placed.

Can I replace a page that has already been
delivered to the system?

Yes. This process is simple and automated as
long as the page has not already been
approved by you. If this is the case then you
simply make contact with your title manager at
Pensord and ask for the page to be removed
prior to resupplying.

If I place a file in the incorrect place
holder do I need to resupply?

No. You simply select the page and re-folio.

Do I have to name my files in a certain way
for :Delano?

No. You will simply need to allocate a place
holder for the files being uploaded. However, if
you comply with our recommended naming
policy this feature can be automated too.

PA G E  E L E V E N

How are the pages viewed in :Delano?

The pages can be viewed and approved using
the built in preview within :Delano which is
extremely quick and efficient. However, should
you need to see a higher resolution preview of
the pages you can choose to download a
ripped PDF of your pages prior to approving.

Can I approve a whole job or do I have to
approve each individual page?

You can tailor it to suit your needs. Some of
our customers approve pages as they see them
and others approve the whole job at a click of
a button.

My boss wants visibility of a job’s progress.
Can he have this without tinkering?

Yes. We believe this is the great thing about
:Delano. You can give view-only access to
people who need to keep tabs on a job’s
progress without fear of them approving or
deleting a page by accident!

Q
A

Q
A

Q

A

Q

A

Q

A

Q

A

Q

A

Q

A

Q

A

Putting you in control

Should you wish to find out more about :Delano or want to use :Delano for the 
delivery and approval of your files then contact your Title Manager, Business 
Development Manager or our Technical Support Team on the usual numbers.



In the latest of our staff profiles, we introduce some of the newest recruits to
Pensord. Tony Jones welcomes them on board and says: “All our new staff are
chosen to complement the skills and experience we already have at Pensord,

and I’m confident they will play an important part in our future progress.”

Q 06300

For Matthew Roberts, 26, this is a first job in the print industry, joining us in
November as a System Administrator from Abbey National. Matthew will cover all IT
duties, providing technical support to all areas of the business. Equipped with an HNC
in Applied Computer Networks, Matthew is currently studying for an MCSA (Microsoft
Certified System Administrator). He says: “I’m excited to join a company like Pensord
with a great future ahead of it.” Outside work Matthew is a keen sportsman.

Chris Pulley returned to the Pensord fold last year after eight years out in the
wilderness! Chris had worked at Pensord for 18 years up until 1997, so why come
back now? Chris explains: “I realised that I wanted to work for a professional outfit
that values its staff.” Bindery Shift Manager Chris, 47, is responsible for all processes
in the Bindery, from scheduling through to dispatch. Outside work he likes to keep fit
walking and weight training.

Sarah Cloudsdale, 26, became a permanent member of staff at the beginning of this
year, after a period of time here as a temporary Bindery Assistant. Sarah’s role is to
help the machine operators in their tasks. She already knew what to expect when she
became permanent and she says: “This is a really good company to work for and they
are great people to work with, we really are like a happy family.” When she’s not
working, Sarah likes to spend time with her son. 

Another full time appointment David James has been working with Pensord as a
Bindery Assistant on a temporary basis for two years. David, 21, works on the end of
the mailing lines preparing polywrapped magazines for collection by Royal Mail and
other distribution networks. He enjoys working here as: “I like the people I work with.”
In his spare time, David enjoys socialising and ‘pubbing and clubbing’ with his friends.

Leighton Grimstead, 19, is a new full time Bindery Assistant this year and normally
works on the Heidelberg ST400 stitching line assisting the stitching operator. 
He previously worked for a label printer and wanted to stay in the industry. 
For Leighton, Pensord is a family affair, with three generations of his family having
worked here. He says: “I was hearing good things about the place, now I’m happy to
be working here myself.”

New Bindery Operator David Bell-Langford, 41, lost his job at the Caerphilly plant of
printer St Ives after 20 years there, when it closed in 2005. He says: “When I was
looking at my options I heard that Pensord had a good future”. David now has a
full-time job on the perfect binder. He is also a skilled folder operator. Outside work
David is a keen angler, a ‘specimen hunter’ in sea, game and coarse fishing.

Pensord people


